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Step 1: Designate authorized users of multi-user licensing web Basic Installation
pages

Basic Installation

This section provides the basic steps in a typical installation of Quality Companion 3. For
instructions on advanced installation options, see Installation options on page 15.

To install Quality Companion 3, follow the steps below. To renew an existing installation that
has reached or is close to reaching its expiration date, see Renewing licenses on page 12.

1 Designate authorized users of multi-user licensing web pages (optional).
2 Determine installation configuration.

3 Create license files at the multi-user licensing web pages.

4 Obtain software.
5

Install software.

Note This installation guide applies only to the multi-user installation for Minitab products.
If you are not sure whether you have a multi-user or single-user license, see
www.minitab.com/support/answers/answer.aspx?id=2517.

Step 1: Designate authorized users of
multi-user licensing web pages

To access the Minitab multi-user licensing web pages so that you can create the license files
for the installation, you must be either the Minitab License Coordinator for your organization
or an authorized user.

At the time of purchase, someone from your company was designated as the Minitab License
Coordinator. That person has permission to log in to the Minitab multi-user licensing web
pages to create license files. In addition, your company can have other authorized users.

If you are not sure whether you're an authorized user, contact your organization's Minitab
License Coordinator. Only the License Coordinator can request additional authorized users
by contacting a Minitab sales representative or Minitab Technical Support.

Step 2: Determine installation configuration

All multi-user installations require Minitab License Manager, the software that manages Quality
Companion based on the information in the license file. Minitab License Manager must be
installed in a configuration that allows it to communicate with Quality Companion.

You can choose from several different installation configurations to suit your needs. For example,
you can install Minitab License Manager on a server in a networked configuration. In a
networked configuration, users access the license file on the server; therefore, each client
computer does not need to be permanently assigned to a separate license file. Another option
is to install Minitab License Manager and Quality Companion on each client computer in a
standalone configuration, which requires a separate license file for each client computer.

The installation configuration you choose affects the number of license files you need to create
and the installation procedures that you need to follow. See Installation Configurations on page
7 for detailed information that will help you to determine the best configuration for your
organization.
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Step 3: Create license file(s)

Basic Installation

Step 3: Create license file(s)

You need at least one license file for installation. To create license files, you use the Minitab
multi-user licensing web pages. One license file per server is required in a networked installation.
One license file per workstation is required in a standalone configuration. See Installation
Configurations on page 7 for more information on networked and standalone configurations.

You need the following information to create a license file:

¢ The maximum number of simultaneous users that will be served by the license. In a

standalone configuration, the maximum number of users is 1 for each license.

To determine the maximum number of users in a networked configuration, see Number of
license files on page 10.

The MAC address of each computer that will host a license. This is the computer's physical
address. To obtain the address, run the DOS command "ipconfig /all" and record the
physical address that appears under Ethernet adapter Local Area Connection. In the example
below, the MAC address of the computer is 01-23-45-AB-CD-EF.

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix.:domain.local

Description....................:Broadom NetXtreme 57XX Gigabit
Controller

Physical Address............... 01-23-45-AB-CD-EF

Dhcp Enabled...................:Yes

Autoconfiguration Enabled......:Yes

IP Address.....................:192.168.1.1

Subnet Mask....................:255.255.255.0

Default Gateway................:192.168.2.100

DHCP Server....................:192.168.2.100

DNS Server..........ceeevee....:192.168.10.200

Lease Obtained.................:Saturday, July 25, 2009 4:07:19 PM

Lease Expires..................:Wednesday, July 29, 2009 4:07:19 PM

For more information on how to obtain a computer's MAC address, see
www.minitab.com/support/answers/answer.aspx?id=2084.

To create 1 Go to http://www.minitab.com/manage-license-files.aspx.

license files

2 Log in as an authorized user.

3 Complete the necessary steps to create the license file(s).

Step 4: Obtain software

All multi-user configurations require both Minitab License Manager and Quality Companion.
The installation files for these applications are available on the installation CD. However, to

To download
software

ensure that you have the latest version of our products, download the applications from the
Minitab Web site using any Minitab.com account.

Go to http://www.minitab.com/support/licensing/multi-user/downloads/default.aspx.

Download Minitab License Manager and Quality Companion. The license file is read by
Minitab License Manager, the server software that manages the use of Quality Companion
based on the information in the license file.
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Step 5: Install software Basic Installation

Step 5: Install software

Install Quality Companion and Minitab License Manager based on the installation configuration
that you determined in step 2. You can install Minitab License Manager on a server in a
networked configuration or on each client computer in a standalone configuration. You can
also install the Dashboard utility on client machines. The Dashboard makes it easy to access
the status of your entire Six Sigma program by aggregating all of your projects into a single
summary view.

Note We recommend that you disable your anti-virus software during the installation of
Quality Companion 3.

System  You can find the latest system requirements for Quality Companion at
requirements  hitp://www.minitab.com/products/quality-companion/system-requirements.apsx.

Toinstallina 1 Ensure that you have administrative privileges to install Minitab License Manager on the
networked server and Quality Companion on each workstation.

configuration 5 e that the license file is on the desktop of the server. See Create License File(s) on

page 4 for more information.
3 Install Minitab License Manager on the server.

4 Delete the license file that is on the desktop. The installation program creates a copy of the
license file in C:\Program Files\Minitab\License Manager. The Minitab License Manager
uses this license file.

5 Install Quality Companion on each workstation.
®  You need to specify the name of your Minitab License Manager server during installation.

¢ Quality Companion chooses the first available port between 27000 and 27009. If your
License Coordinator specified a different port within the license file, check Specify port
number, and enter that port number.

Note After you set up a networked configuration, you can use the Minitab License Borrowing
Utility to allow a portable workstation, such as a laptop, to run Minitab products while
itis disconnected from the network. See Using Minitab products while disconnected from
the network on page 7 for more information. Borrowing is not available in all regions.
See www.minitab.com/support/answers/answer.aspx?id=2449 to determine whether
your license is borrow-enabled.

Toinstallina 1 Ensure that you have administrative privileges to install Minitab License Manager and
standalone Quality Companion on each workstation.

configuration

[N ]

Ensure that the license file is on the desktop of the workstation. See Create License File(s)
on page 4 for more information.

3 Install Minitab License Manager on each workstation.

4 Delete the license file that is on the desktop. The installation program creates a copy of the
license file in C:\Program Files\Minitab\License Manager. The Minitab License Manager
uses this license file.

5 Install Quality Companion on each workstation.

¢  When prompted for the name of the Minitab License Manager server, enter localhost.
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Step 5: Install software Basic Installation

¢ Quality Companion chooses the first available port between 27000 and 27009.

Toinstall 1 Download Quality Companion Dashboard from
Dashboard http:/lwww.minitab.com/support/downloads/quality-companion/resources.aspx

2 Follow the installation instructions.

Note Dashboard does not require a license to run. To use Dashboard, you must have
access to Quality Companion projects.
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Multi-user installation Installation Configurations

Installation Configurations

Basic Installation on page 3 explained how to install the multi-user version of Minitab products.
This section provides a more in-depth explanation of the client-server model and the possible
installation configurations.

Multi-user installation

The multi-user versions of Minitab products are based on a clientserver installation model.
Quality Companion (the client software) is installed on individual workstations. Minitab License
Manager (the server software) is installed on a server. Every time the client software is started,
it communicates with the server to ensure that a license is available.

Typically, Minitab License Manager is installed on a single server. The client software can be
installed on an unlimited number of workstations. Minitab License Manager ensures that the
number of concurrent users never exceeds the licensed number of seats.

For example, an organization purchased 100 licenses of Quality Companion and configured
Minitab License Manager to control all 100 licenses. Quality Companion was installed on 300
workstations. Even though the client software has been installed on 300 workstations, Minitab
License Manager will allow only 100 instances of the client software to run concurrently.

When the client software is started, it requests a license from Minitab License Manager. If a
license is available, it is sent it to the client and the software starts successfully. If a license is
not available, an error message is displayed.

Configuration options

Networked  To set up a networked configuration, install Minitab License Manager on a server. A license
configuration file is requested during the installation process. You need to provide the license file that was
created during the procedure detailed in Basic Installation on page 3 (license files should
always be named "minitab.lic"). Minitab License Manager is installed to C:\Program
Files\Minitab\License Manager (by default). The installation program makes a copy of the
license file and places it in the installation directory.

The Minitab License Manager installation creates a Windows service called Minitab License
Manager. The license manager service starts automatically when it is installed. When the service
starts, it checks the Minitab License Manager installation directory for the license file. If the
license file is valid, the service starts successfully.

Install the client software, Quality Companion, on as many workstations as necessary. During
installation, you need to provide the name of the server on which Minitab License Manager
is installed.

Using Minitab  In a multi-user installation of Quality Companion, the client software must be able to
products  communicate with the Minitab License Manager server to start. To allow a portable workstation,
while such as a laptop, to run Minitab products when it is disconnected from the network, Minitab
disconnected  Provides the Minitab License Borrowing Utility.

from the
network
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Minitab License Manager Installation Configurations

Standalone
configuration

Mixed
configurations

To restart
Minitab
License

Manager

For example, you might use Quality Companion on a laptop when you travel for business.
Before leaving, while still connected to your company's network, use the Minitab Borrowing
Utility to acquire a license from the Minitab License Manager server. Then you can access
Quality Companion on the laptop when you are disconnected from the network.

For more information, refer to License Borrowing Instructions. Go to
http:/lwww.minitab.com/support/licensing/multi-user/documentation/default.aspx. To download
the Minitab License Borrowing Tool, go to
http:/www.minitab.com/support/licensing/multi-user/downloads/default.aspx.

Note Borrowing is not available in all regions. See
www.minitab.com/support/answers/answer.aspx?id=2449 to determine whether your
license is borrow-enabled.

In a standalone configuration, Minitab products do not depend on accessing a network server.
Instead, the Minitab License Manager server software is installed on the same workstation as
the client software, Quality Companion. When Quality Companion starts, it checks the Minitab
License Manager service that is on the same workstation, regardless of network connectivity.
An individual license file must be created for each workstation.

You can use a combination of networked and standalone configurations. For example, you can
install Quality Companion on 20 workstations that are connected to the company's network
and also install Quality Companion on 5 standalone workstations that are not connected to the
network.

For information on mixed installation configurations and license files, see Number of license
files on page 10.

Minitab License Manager

All multi-user installation configurations require the installation of the Minitab License Manager,
the server software that manages the use of Quality Companion. The Minitab License Manager
ensures that the number of concurrent users does not exceed the licensed number of seats,
based on the information in the license file.

The Minitab License Manager starts its service automatically when you install it. However, you
may need to restart the Minitab License Manager service in some cases, such as when you
make changes to the license file or use an options file.

1 Open Windows services on the computer:

e In Vista or later, click the Windows logo (Start). Type services.msc in the search box
and press Enter.

® In other Windows versions, choose Start > Run. Type services.msc and click OK.

2 Click Minitab License Manager.

3 Choose Action > Restart.

Note If you need to uninstall Minitab License Manager from a computer, such as when you
change servers or installation configurations, you must first stop the license manager
service. Follow steps 1 and 2 above; in step 3, choose Action > Stop. Then uninstall
the Minitab License Manager.
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Using license files License Files

License Files

License files are required for the installation of Minitab multi-user products. This section
provides general background information on license files, including what they are, where they're
created and stored, and how they're used. For instructions on how to work with license files
after installation, see License Manager Ultility on page 16.

Using license files

Whatisa  Alicense file is a text file named minitab.lic. The file does not have a .txt extension, but you
license file? can open it in a standard text editor such as Notepad. The file contains information about the
licenses that your organization purchased. This information includes the expiration date, the
number of licenses, and the computer's MAC address.

After you create a license file at the Minitab multi-user licensing web pages, save it to the
desktop of the computer on which you will install the Minitab License Manager, the server
software that manages the use of Quality Companion based on the information in the license

file.

Sample license file

SERVER this_host 0A1B2C3D4ESF

VENDOR minitab

USE_SERVER

INCREMENT Minitab quality companion 31-dec-2011 100 VENDOR_STRING="1limited \

term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2011 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENIO1234"™ SN="STDORD56789 01234INC" START=01-oct-2010 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B OF38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"

In the sample license file above, the terms in bold specify the following information:

0A1B2C3DA4ESF the unique MAC address of the computer for which this license
file was created.

quality companion the name of the product for which the license file was created.

31-dec-2011 the expiration date of the license file.

100 the number of users allowed to concurrently run Minitab.

Fach license file is created for a single computer. The computer is identified in the license file
by its MAC address. The license file cannot be used on a computer that does not have the
MAC address specified in the license file.

How license  During the installation of Minitab License Manager, you need to provide the location of the
files are used  license file. By default, the installation looks to the desktop for the license file and then creates
a copy of the license file in C:\Program Files\Minitab\License Manager. The Minitab License
Manager service is then installed. The service reads the license files and then starts.

Note After you install Minitab License Manager, you can delete the license file that is on the
desktop.
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Adding a second product or additional users to your license License Files
file

Authorized users can create license files at the Minitab Multi-User Licensing web pages. See
Create License File(s) on page 4 for more information.

Number of  You need one license file for each Minitab License Manager that you install. In a typical

license files networked configuration, Minitab License Manager is installed on a single server. In this case,
only one license file is needed. For example, Minitab License Manager is installed on a single
server that will serve all 100 licenses. You need to create a single license file for all 100 seats.

You can also divide your licenses among multiple servers, if desired. For example, Minitab
License Manager is installed on two servers, one for 75 users in Department A and the other
for 25 users in Department B. This installation configuration requires two license files: one file
for 75 seats and another file for 25 seats.

In a standalone configuration, Minitab License Manager must be installed on each workstation.
As a result, a unique license file is required for each installation of Minitab License Manager.
For example, a small computer training lab has 10 computers that are not networked. You need
to install Minitab and Minitab License Manager on all 10 computers. This installation
configuration requires 10 license files, one for each computer.

You can have a combination of networked and standalone installations. You need to create a
single license file for the server and a separate license file for each standalone workstation. For
example, an organization purchases 100 licenses for Minitab. They want 10 standalone
installations in the computer lab. A single server will host the remaining 90 licenses. This
installation configuration requires 11 license files: one for the server and one for each of the
10 standalone workstations.

Adding a second product or additional users
to your license file

When you purchase both Minitab Statistical Software and Quality Companion, you must
initially create two separate license files at the multi-user licensing web pages, one for each
product. However, to install both products, you need to merge the two license files into one
file. After you download both license files, append the contents of one license file to the other
license file.

You can also add additional users to your license, which also involves appending the contents
of your new license file to the existing file.

To append an 1 At hitp://www.minitab.com/manage-license-files.aspx, create a separate license file for the
additional additional product.

pr(?dUCt to_ A 2 Save the new license file to the desktop. Do not overwrite the existing license file in
license file C:\Program Files\Minitab\License Manager.

Open the new license file for the additional product in Notepad.

Copy everything from the INCREMENT line down.

Close the license file that is on the desktop.

Open the original license file in C:\Program Files\Minitab\License Manager in Notepad.

Paste the copied contents of the new license file to the end of the original license file.

coO 31 N VI A~ W

Choose File > Save.
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Adding a second product or additional users to your license License Files

file

Example of a
license file
with
appended
product

To append
additional
users to a
license file

9 Restart the Minitab License Manager service. See To restart Minitab License Manager on
page 8 for more information.

10 To verify your change, double-click Imtools.exe in the installation directory (by default,
C:\Program Files\Minitab\License Manager).

11 Click the Server Status tab.
12 Click Perform Status Enquiry.

13 In the results window, look for the line that includes Users of product where product =
the Minitab product you added to your license.

SERVER this_host 0A1B2C3D4ESF

VENDOR minitab

USE_SERVER

INCREMENT qualitycompanion minitab 3 31-jan-2012 8 VENDOR_STRING="Tlimited \
term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-mar-2011 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENIO1234" SN="STDORD31415 01234INC" START=01-nov-2010 \
SIGN="1EA6 00D1 E785 EEA9 F026 63B5 BBA® B8BO CAB9 \
91CA A57A D123 D9DD 0372 A1CD 136F 12F4 ABCB EAGA 3AD9 A71F \
FO014 7B78 A683 6EB2 FCC6 9685 0D66 6355 441C"

INCREMENT Minitab minitab 16 31-dec-2011 50 VENDOR_STRING="1limited \
term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2011 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENIO1234" SN="STDORD56789 01234INC" START=01-oct-2010 \
SIGN="1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B OF38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"

1 At http://www.minitab.com/manage-license-files.aspx, create a separate license file for the
additional users.

2 Save the new license file to the desktop. Do not overwrite the existing license file in
C:\Program Files\Minitab\License Manager.

Open the new license file for the additional users in Notepad.

Copy everything from the INCREMENT line down.

Close the license file that is on the desktop.

Open the original license file in C:\Program Files\Minitab\License Manager in Notepad.
Paste the copied contents of the new license file to the end of the original license file.

Choose File > Save.

N el R N =) B NV ]

Restart the Minitab License Manager service. See To restart Minitab License Manager on
page 8 for more information.

10 To verify your change, double-click Imtools.exe in the installation directory (by default,
C:\Program Files\Minitab\License Manager).

11 Click the Server Status tab.
12 Click Perform Status Enquiry.
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Renewing licenses License Files

13 In the results window, look for the line that includes Total of x licenses issued and
confirm that x is equal to the total number of licenses (original + added).

Example of a  SERVER this_host 0A1B2C3D4ESF
license file  VENDOR minitab

. USE_SERVER
with INCREMENT Minitab quality companion 31-dec-2011 8 VENDOR_STRING="1limited \
appended term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2011 BORROW=26280 \
users NOTICE="Customer ID: 01234 License Coord ID: 56789 \

RENI01234"™ SN="STDORD56789 01234INC" START=01-oct-2010 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B OF38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"

INCREMENT Minitab quality companion 31-jan-2012 25 VENDOR_STRING="limited \
term, limited users, borrowing enabled" DUP_GROUP_UH \
ISSUER=Minitab ISSUED=01-mar-2011 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENIO1234" SN="STDORD31415 01234INC" START=01-nov-2010 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B OF38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"

Renewing licenses

To avoid "checkout failed" error messages that are caused by expired license files, renew your
organization's Quality Companion license before it expires.

1 Your organization's License Coordinator must purchase a new license for your organization.

2 An authorized user must log in and generate new license files at
http://lwww.minitab.com/manage-license-files.aspx.

See Step 3: Create license file(s) on page 4 for more information about creating license

files.

3 Replace the existing license file with the new license file in C:\Program
Files\Minitab\License Manager.

4 Restart Minitab License Manager. See To restart Minitab License Manager on page 8 for
more information.

Note License files are created with an expiration date. Quality Companion will not start if
the license is expired.
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Command line installation Advanced Topics

Advanced Topics

Command line installation

For general installation instructions, please refer to Basic Installation on page 3.

You can use the command line to install Quality Companion 3 and the Dashboard on the
client machine. When you install Quality Companion using the command line, you must
specify the license information for each installation using the appropriate command line syntax.
You do not need a license for the Dashboard.

From the client machine, execute the following commands as one continuous line of text,
substituting your information for italicized text:

® msiexec.exe /i
® '"path to installation files\Companion\Quality Companion 3.msi" /qgn

® MINITAB_LICENSE_FILE="machine" (for example, hostname where hostname is the name
of the license manager machine)

® INSTALLDIR="path to where you want to install application” (If you do not
specify a location, Quality Companion 3 uses C:\Program Files\Quality Companion
3.)

® WORKGROUP="path to workgroup template folder" (This location, such as a network
folder, stores templates that team members need to share. It has no default value.)

® PERSONAL="path to personal template folder” (Thislocation on a user's computer
stores templates that only the user needs to access.)

® DATA="path to the initial data folder" (This location first appears as the default
location whenever a user saves tools and projects.)

® SHORTCUT="1" to install the desktop shortcut or SHORTCUT="2" to not install. (Quality
Companion 3 installs the desktop shortcut by default.)

® UPDATE="1" to enable notifications and updates, or UPDATE="0" to disable notifications and
updates. (Quality Companion 3 enables notifications and updates by default.)

Your command line might look similar to this example without line breaks:

msiexec.exe /i "D:\Companion\Quality Companion 3.msi" /qgn
MINITAB_LICENSE_FILE="hostname" INSTALLDIR="C:\Program Files\Quality
Companion 3" WORKGROUP="\\Serverl\Quality Companion\Shared Templates"
PERSONAL="C:\Quality Companion\My Templates" DATA="C:\Quality
Companion\Data" SHORTCUT="1" UPDATE="1"

Administrative installation

For general installation instructions, please refer to Basic Installation on page 3 .

You can create a server installation image on the network and deploy Quality Companion 3
and the Dashboard to clients by running the server installation image. You only need to specify
the license information one time when you create the server installation image when you install
Quality Companion. You do not need a license for the Dashboard.

You can create the server installation image in one of the following ways:
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Create server
installation
image using
the interface

Deploy from
image using
the interface

Deploy from
image using
the command
line

e Use the administrative installation interface.
e Use the command line.

After you create the server installation image, you can deploy Quality Companion 3 in at least
one of two ways:

® Use the server installation image interface.

e Use the command line.

To create the server installation image using the server installation interface:

1 Ifinstalling from the installation CD, insert the disk into the CD-ROM drive of your
workstation.

Note | If the installation splash screen appears, choose the option to exit.

2 To invoke the server installation interface, execute the following commands as one
continuous line of text, substituting your information for italicized text:

msiexec.exe /a "path to installation files"\Companion\Quality Companion
3.msi"

Your command line might look similar to this example:

msiexec.exe /a "D:\Companion\Quality Companion 3.msi"

3 Follow the prompts in the dialog boxes. During the installation, you will:
¢ Enter the network location where you want to store the server installation image.
¢ Enter the name of the license manager machine.
e Determine if you want a shortcut to Quality Companion 3 on the desktop.

¢ Determine if you want to allow users to download and install updates.

To deploy from the server installation image using the interface, perform the following steps:

1 From the client machine, navigate to the server installation image that you created on the
network.

2 Double-click the .MSI file.
3 Follow the prompts on the screen. During the course of the installation, you will:
® Accept the terms of the license agreement.

® Accept the default installation folder (C:\Program Files\Quality Companion 3)or
choose a different folder.

From the client machine, execute the following commands as one continuous line of text,
substituting your information for italicized text:

® msiexec.exe /i
® '"path to server installation image\Quality Companion 3.msi" /qgn

® optional property INSTALLDIR
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To perform an
advanced
installation

To manually
check for
updates

To change the
schedule for
automatic
updates

Advanced Topics

Your command line might look similar to this example without line breaks:

msiexec.exe /i "\\Serverl\Shared Image\Quality Companion 3\Quality Companion
3.msi" /gqn INSTALLDIR="C:\Program Files\Quality Companion 3"

Installation options

When you install Minitab, you can choose several advanced installation options. After you
choose the language, accept the license agreement, and enter license manager information,

click Advanced to:

AN V1 AW N -

Change the destination folder. By default, Quality Companion is installed to C:\Program
Files\Mintab in the Quality Companion 3 folder.

Install a desktop shortcut.
Install the Minitab Software Update Manager.

Note If you choose not to install the Minitab Software Update Manager on your computer
or those of your end-users, you will not be informed of critical software updates. Without
the Minitab Software Update Manager, you will not be able to easily identify which
updates apply to the software version that is installed on your computer(s). We
recommend that you install the Minitab Software Update Manager on at least one
regularly monitored computer so that you can receive notices and updates.

After you add license manager information, click Next and then click Advanced.

If you like, type a new destination folder or click Change to browse to a different location.
Click Next.

Check Install a desktop shortcut to include a desktop shortcut to Quality Companion.
Check Install Minitab Software Update Manager.

Click Install.

Checking for updates

If you installed the Minitab Software Update Manager, it automatically checks for updates
every month and gives each user the ability to manually check for updates at any time.

1
2
3

Open Minitab.
Choose Help > Check for Updates.

Select the updates you want and click Install update(s).

You can change how often the Update Manager automatically checks for updates.

1
2
3
4

Open Minitab.
Choose Help > Check for Updates.
Click Preferences.

Choose Daily, Weekly, Monthly, or Never.
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To specify a
license
manager port

5 Click OK

Note If you choose Never to check for updates, you will not be automatically informed of
critical updates, bug fixes, or notifications of problems or errors. However, Quality
Companion users can still check for Quality Companion updates manually.

License manager utility

Flexera Software, formerly Acresso, provides the Imtools.exe utility for performing license
management tasks. This utility provides a graphical user interface to access all the license
management tasks. To use LMTOOLS, navigate to the license manager installation folder

(C:\Program Files\Minitab\License Manager by default) and double-click 1mtools.exe.

For more information on LMTOOLS, refer to the FLEXnet Licensing End User Guide distributed
by Flexera Software.

You can use this utility to check the status of Minitab License Manager and to help you monitor
network licensing activities, such as the number of licenses in use and who is using them. You
can also review configuration settings. See Check Minitab License Manager status and settings
on page 19 for more information.

Specifying ports

Minitab uses two ports for communication between the workstation and the server: the license
manager (Imgrd.exe) port and the vendor daemon (minitab.exe) port. You can modify the
license file to specify which port numbers Minitab should use.

Specifying ports manually is useful when you need to identify them as open ports on firewalls.
When communication appears to be blocked, configure these open ports on any firewall on
or between the workstation and server, including software firewalls such as Windows firewall.
See FLEXnet error 96 on page 21 for more information.

You can specify both the license manager and vendor daemon ports in the same license file.
Make a backup of your license file before you edit it.

The license manager (Imgrd.exe) automatically chooses the first available port between 27000
and 27009 each time the Minitab License Manager service starts. You can set this port number
to a permanent value.

1 Open the license file in C:\Program Files\Minitab\License Manager in Notepad.

2 Type the port number after the MAC address on the first line. Leave a space between the
MAC address and port number, as shown in the example below step 7.

3 Save the file.

4 Restart the Minitab License Manager service to re-read the license file. See To restart Minitab
License Manager on page 8.

5 To verify your change, open the Minitab License Manager log file, minitab.dl, which is
located at C:\Program Files\Minitab\License Manager, in Notepad.

6 Locate the line that includes Imgrd tcp-port.

7 Make sure that the port number on this line is correct. For example, 1mgrd tcp-port
27001 .
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Option:s file Advanced Topics

Example of license file with specified license manager port of 27001:

SERVER this_host 0A1B2C3D4ES5F 27001

VENDOR minitab

USE_SERVER

INCREMENT Minitab minitab 16 31-dec-2011 100 VENDOR_STRING="1limited \
term, limited users, borrowing enabled” DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2011 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENIO1234” SN="STDORD56789 01234INC” START=01-oct-2010 \
SIGN="1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B OF38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39”

To specify a  The four-digit vendor daemon (minitab.exe) port is dynamically assigned from a wide range of
vendor  port numbers each time the Minitab License Manager service starts. You can set this port
daemon port  number to a permanent value.

1 Open the license file in C:\Program Files\Minitab\License Manager in Notepad.

2 Type port=and the port number at the end of the second line ("port” is case-sensitive).
Leave a space between minitab and port=.

3 Save the file.

4 Restart the Minitab License Manager service to re-read the license file. See 1o restart Minitab
License Manager on page 8.

5 o verify your change, open the Minitab License Manager log file, minitab.dl, which is
located at C:\Program Files\Minitab\License Manager, in Notepad.

6 Locate the line that includes minitab using TCP-port.

7 Make sure that the port number on this line is correct. For example, minitab using
TCP=port 3000 .

Example of license file with specified vender daemon port of 3000:

SERVER this_host 0A1B2C3D4ESF

VENDOR minitab port=3000

USE_SERVER

INCREMENT Minitab minitab 16 31-dec-2011 100 VENDOR_STRING="1limited \
term, limited users, borrowing enabled” DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2011 BORROW=26280 \

NOTICE="Customer ID: 01234 License Coord ID: 56789 \

RENIO1234” SN="STDORD56789 01234INC” START=01-oct-2010 \

SIGN="1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \

Options file

You can use the options file to control various license system options for the Minitab License
Manager, such as reserving licenses for a person or group or excluding licenses for a person or

group.

To use an 1 Open a new file in Notepad.

options file 2 Type your settings with the appropriate syntax, as documented in the FLEXnet Licensing

End User Guide distributed by Flexera Software, formerly Acresso. See the bottom of this
topic for an example options file.

3 Choose File > Save As and browse to the same folder as minitab.lic (C:\Program
Files\Minitab\License Manager).
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Option:s file Advanced Topics

In File name, type minitab.opt.
In Save as Type, choose All Files.
Click Save.

~N N V1

Restart the Minitab License Manager service. See To restart Minitab License Manager on
page 8.

8 To verify that the options file is successfully implemented, open the Minitab License
Manager log file, minitab.dl, at C:\Program Files\Minitab\License Manager, in Notepad.

9 Locate the line that includes Using options file:<path_to_options_file>. If this text
is present, the options file has been successfully implemented.

If a minitab.opt is present, the Minitab License Manager service reads it and implements the
settings in the file.

In the example below of an options file, line 1 prevents the user tjones from using Minitab.
Line 2 prevents the same user from using Quality Companion. Line 3 creates a group named
"quality" and defines members of that group. Line 4 reserves three licenses for the quality group.
EXCLUDE Minitab USER tjones

EXCLUDE qualitycompanion USER tjones

GROUP quality jsmith bmiller awilson
RESERVE 3 minitab GROUP quality

Note Go to www.minitab.com/support/answers/answer.aspx?ID=2344 for more information
about the option:s file.
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Log files Troubleshooting

Troubleshooting

This section provides information for troubleshooting problems related to licensing and installing
Minitab products.

Log files

Quality Companion 3 and Minitab License Manager each generate log files to use for
troubleshooting.

Installation  An installation log file is created when you install Quality Companion. The file is named
log file  setup.log and is located at % TEMP\QualityCompanion3.

The installation log file contains information such as the time and date of installation and the
folder to which the software was installed.

In Windows XP:

1 From the Windows taskbar, choose Start > Run.
2 In Open, type $TEMP%\Quality Companion 3.
3 Click OK

4 Browse to Setup.log.

In Windows Vista or Windows 7:

1 Click the Windows logo (Start).

2 Press Enter.

3  Browse to Setup.log.

Minitab  Minitab License Manager is the server software that controls the use of your license. It generates

License  alogfile thatis updated with events, such as license check-ins, check-outs, and error messages.

Manager log By default, the log file is named Minitab.dl and is located at C:\Program Files\Minitab\License
file Manager.

To read the Minitab License Manager log file, open it in Notepad.

Note For detailed information on the Minitab License Manager log file, refer to the FLEXnet
Licensing End User Guide distributed by Flexera Software, formerly Acresso.

Check Minitab  You can check the status of Minitab License Manager to help you monitor network licensing
License activities, such as the number of licenses in use and who is using them. You can also review

Manager configuration settings.

status and 1 Navigate to Minitab License Manager folder (by default, at C:\Program Files\Minitab\License
settings Manager).

2 Double-click 1mtools.exe.
3 Do any of the following:

¢ To check server status, click the Server Status tab. Click Perform Status Enquiry.
e To check server configuration, click the Config Services tab.
¢ To check license information, click the Server Diags tab. Click Perform Diagnostics.
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FLEXnet license errors

FLEXnet error
15

FLEXnet error
34

FLEXnet error
92

Troubleshooting

The number of licenses are listed, as shown in this example:

Users of Minitab:
use)

(Total of 50 licenses used; Total of 33 licenses in

Specific details about each license are also listed:
jsmith LAB_PCLAB_PC (v1.0)(LAB_PC/27000 302), start Fri 3/1 4:15

jsmith is the user name, LAB_PC is the computer name, and 27000 is the license

manager port

Borrowed licences display the expiration in seconds. For example, the license below

will expire in 314159 seconds:

jsmith LAB_PCLAB_PC (v1.0)(LAB_PC/27000 302), start Fri 3/1 4:15 (linger:

314159)

FLEXnet license errors

You may encounter several types of FLEXnet error messages that indicate that you cannot
check out a license. These messages are formatted in general as follows:

FLEXNET License Error Number:

For example:

Error text.

FLEXNET License Error -97-121-0: Check out failed

Some of the errors that you may encounter are listed below. For a complete list of possible error
codes, see the FLEXnet Licensing Iind User Guide.

Possible cause

Explanation

The server name that was provided during the
installation of Quality Companion 3 on the
client computer is not valid.

Possible cause

The server name that was provided during the
installation of Quality Companion 3 on the
client computer is used to locate that server on
the network. Make sure that the server name
is valid. For instructions on locating the server
name, see
www.minitab.comy/support/answers/answer.aspx?id=2085.

Explanation

The date differs in excess of 24 hours between
the client computer and the Minitab License
Manager server.

Possible cause

If the date difference is greater than 24 hours,
Minitab License Manager will refuse to grant
the license. Reset the clock on the client
computer.

Explanation

The MAC address in the license file does not
match the MAC address of the Minitab License
Manager server.
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FLEXnet license errors

FLEXnet error
68

FLEXnet error
95

FLEXnet error
96

FLEXnet error
97

Possible cause

Troubleshooting

Explanation

Possible cause

adapter on Minitab License Manager. See
License Files on page 9 for more information.

Explanation

The license file is not configured to allow for
borrowing.

Possible cause

Not all licenses are borrow-enabled.
Borrow-enabled licenses will have
"borrow-enabled" within the text of the license
file.

Explanation

You are browsing to a license file in a
standalone configuration.

Possible cause

Your license type may not support this method.
In the Find License dialog box, instead of
choosing Specify the License File, choose
Specify the License Server System. Type the
server name. For example, type @localhost.

Explanation

Firewalls or network configurations are blocking
communications between the client computer
and the Minitab License Manager server.

The client computer must be able to
communicate with the Minitab License
Manager server over two ports: the Minitab
License Manager (Imgrd.exe) port and the
minitab vendor daemon (minitab.exe) port.
You can use telnet to test communications. See
www.minitab.comy/support/answers/answer.aspx?id=2178
for more information on telnet. See the Minitab
License Manager log file on page 19 to
determine which port numbers are used. See
Specifying ports on page 16 to manually
configure ports.

The Minitab License Manager service is not
running on the license server.

Possible cause

The Minitab License Manager service must be
running to process license requests for Minitab.

Explanation

The MAC address in the license file does not
match the MAC address of the Minitab License
Manager server.

The MAC address in the license file must match
the MAC address of an enabled network
adapter on Minitab License Manager. See
License Files on page 9 for more information.

The license expired.

The expiration date for your license is specified
in the license file.Quality Companion is not
usable after the expiration date. See License Files
on page 9 for more information.

The network adaptor on the Minitab License
Manager server is disabled.

The network adaptor card must be enabled for
the Minitab License Manager server to verify
the MAC address. Without this, Minitab cannot
start. This issue is most commonly encountered
with laptop computers that may change the
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Minitab License Manager fails to start

FLEXnet error
104

Possible cause

Troubleshooting

Explanation

status of a network card under various
conditions.

The license file was modified.

You can make a few valid changes to the license
file, such as specifying a port number. Most
other changes will corrupt the license file,
making it unusable to Minitab License Manager.

The date is incorrect on the computer that runs
Minitab License Manager software.

Minitab installations are sensitive to the
computer's date.

Minitab License Manager is installed to
C:\FlexLM\Minitab.

Minitab License Manager should not be
installed to this directory. Uninstall Minitab
License Manager and install to another
directory. See
www.minitab.comy/support/answers/answeraspx?id=2251
for more information.

The Minitab License Manager service is not
running on the license server.

The Minitab License Manager service must be
running to provide license requests for Minitab.

Minitab License Manager is using a different
communication port than expected.

Possible cause

Multiple FLEXIm license managers may be
running on this server, which caused the
Minitab License Manager to use a different port.
See To specify a license manager port on page
16 to manually configure ports.

Explanation

You attempt to borrow a license longer than is
allowed by either the expiration date in the
license file or a limit set in the options file.

You cannot borrow a license beyond the
expiration data of the license file. If the specified
end date for borrowing is before the expiration
date, the options file may contain limits on
borrowing. See Options file on page 17 for more
information.

Minitab License Manager fails to start

If the Minitab License Manager service fails to start, you may see the following error message:

The Minitab License Manager service on Local Computer started and then
stopped. Some services stop automatically if they have no work to do, for
example, the Performance Logs and Alerts Services.

Use the following table to troubleshoot the problem:

Possible cause

Explanation

The license file (minitab.1ic) is not in the
Minitab License Manager installation directory.

Minitab License Manager browses to
C:\Program Files\Minitab\ License Manager
for the license file. Ensure that minitab.lic is at
this location.

The license file is not named correctly.

The license file must be named "minitab.lic"
(unless this default value was modified later).
Make sure that the file is not named

Quality Companion 3 Installation Guide
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Web site errors

Access Denied

Unable to
Proceed:
Entitlements
Not Available

Possible cause

Troubleshooting

Explanation

minitab.lic.txt (a common mistake). Confirm
that the file does not end with .txt. Right-click
the file, choose Properties, and verify that Type
of file is License and not Text Document.

Extra text is in the license file.

Some text editors, such as WordPad, may add
unwanted content to your file. See Sample
license file on page 9 for an example of a
license file with no unnecessary text. Open the
file in Notepad.

Minitab License Manager does not have
permission to write the log file (ninitab.d1)
to the directory specified in the Config Services
tab of LMTOOLS.

By default, Minitab License Manager creates
minitab.dl in C:\Program Files\Minitab\License
Manager. You can specify a different directory
with LMTOOLS (Imtools.exe). Make sure that
the account that runs the Minitab License
Manager service has write access to this
directory.

Minitab License Manager server has non-ANSI
characters in its name.

Web site errors

For best results, install Minitab License Manager
to a computer with only ANSI characters in its
name.

If you try to log in to the Minitab multi-user license management web pages and you are not
an authorized user, the Access Denied error message may appear. For more information, see
Step 1: Designate authorized users of multi-user licensing web pages on page 3.

If you log in to the multi-user license management web pages to create license files and there
are no valid orders for your organization, the message Unable to Proceed: Entitlements
Not Available appears. Contact your Minitab Sales Representative.

Online resources

The following online resources are available:

e Customer support questions in the Minitab Knowledgebase at

www.minitab.com/support/answers/

e The latest downloads for Minitab multi-user products at
http:/www.minitab.com/support/licensing/multi-user/downloads/default.aspx

¢ The latest documentation for Minitab multi-user products at
http:/lwww.minitab.com/support/licensing/multi-user/documentation/default.aspx

¢ The FLEXnet Licensing End User Guide at
wwwimiritabeormisploadedliiles/Shared_ResourcesDocumments/License_Managementfiexet licensing end user guidepdf
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